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Chapter 1. Advanced use of IBM Infoprint Designer for iSeries

IBM Infoprint Designer for iSeries provides a fully-graphical document
composition interface to the iSeries-AS/400 printing system. It supports the
requirements of today’s complex documents and reports, producing fully
electronic documents combining data, text, electronic forms, graphics, image, bar
coding and typographic fonts. Infoprint Designer can be used for the design of
new output applications or the re-engineering of existing applications.

Infoprint Designer consists of three components

Overlay Editor designs overlays (electronic forms) to be used in the print
application

Image Editor designs images to be used in the print application

Layout Editor  puts all the design components together into the final electronic
document

With Infoprint Designer you can build complex electronic print applications easily.
It manages the upload of the resources you design to the iSeries system. Then,
once the printer file is enabled for use with Infoprint Designer resources, the
original application is automatically transformed with your new design and layout.

1.1 Getting started with Infoprint Designer

The manual, IBM Infoprint Designer for iSeries: Getting Started, G544-5773, is
the primary reference for use with this product. It covers topics such as product
prerequisites, installation and the basic tasks within each of the three
components. It also describes the formatting required to produce more complex
applications, such as an “either/or” page layout. For example, whether to print the
final (totals) page of an invoice, or to print the standard full-page item listing page
within the invoice. The manual then describes how to implement the new design
and layout with the original print application.

The chapter in this Redbook covers more advanced use of Infoprint Designer. You
should read and thoroughly understand the Getting Started manual before using
the information in this chapter.

1.2 Setting up the PC libraries

© Copyright IBM Corp. 2001

You may need to tell Infoprint Designer the name and location of “libraries” where
Infoprint Designer can find the AFP resources you use and/or create. These are
actually Windows directories on your PC. Infoprint Designer already has the
following default locations for:

* AFP overlays
« AFP font resources (coded fonts, character sets, code pages)

images (AFP page segments, PC TIFF files) The paths for the above resources
are stored in a file called the library profile, with an extension of LBP. Infoprint
Designer creates the following two library profiles in the \DESIGNER\USERISIS
directory during the installation process:
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DEFAULT.LBP This is the default library profile for use with Infoprint
Designer. The fonts directory path specifies AFP outline
fonts.

RASTER.LBP This alternative library profile specifies a fonts directory
containing AFP raster (bitmap) fonts.

AFP outline fonts are resolution-independent scalable fonts that provide an
almost unlimited range of point sizes. However your AFP printer must be capable
of receiving such fonts. If your printer does not accept them, or you are using an
ASCII printer with Host Print Transform, normal font substitution will occur
(typically substitution of printer-resident for host-resident fonts).

Both library profiles specify default paths as shown in Table 1 on page 5. This
table also shows the default PC file suffix used to denote a resource type.

To check your library profile, select Defaults - Libraries from the main menu in
Infoprint Designer. You cannot change it from here - instead use Edit - Change
library. However, avoid doing this in the middle of a project. The preferred way of
switching to a new library profile is to select File - New project and browse for a
different library profile. (See the Figure 1, “Starting an overlay project” on

page 6).
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Table 1. Infoprint Designer default AFP resource locations
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ggfs?;:wtelrlfgggt?;n Type of AFP resources stored Defali\lltzgcr:;éloeusrlézix of
C:\DESIGNER

\OGL Overlay source files OGL
\OVL240 240-pel overlay objects OVL
\OVL300 300-pel overlay objects OvL
\OVL600 600-pel overlay objects OvL
\FONTS\CODEPAGE Font code pages none
\FONTS\OUTLINE Outline fonts OLN
\FONT\RASTER 240-pel and 300-pel raster fonts 240, 300
\PSEG240 240-pel page segments 240
\PSEG300 300-pel page segments 300
\PSEG600 600-pel page segments 600
\TIFF PC tagged image format (TIFF) files TIF
\PPFA Page and form definition source files PFA

The location for page and form definition source is not defined in the library
profile, but defaults to \DESIGNER\PPFA.

It is a good idea to define your own libraries for storing self-created resources
such as overlays and page segments. Infoprint Designer uses common suffixes
such as 240, 300 and 600 to distinguish between different resolutions of fonts.
These values are also used for convenience with page segments but it is the
directory location that Infoprint Designer needs (PSEG240, PSEG300 and

PSEGG600).

Other AFP applications such as the AFP Viewer use the following suffixes:

Table 2. Common AFP resource suffixes

AFP resource Suffix
Overlay oLy
Page segment PSG
Form definition FDE
Page definition PDE

You should be aware of the resolution of the resources you will be using. The
following AFP resources are resolution-dependent (i.e. will be either 240, 300 or

600-pel)

« Overlay objects
» Page segments

* Raster font character sets

* Raster coded fonts

Typically they are 300-dpi. All other AFP resources are resolution-independent.

Chapter 1. Advanced use of IBM Infoprint Designer for iSeries 5
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1.3 Starting a project

Infoprint Designer uses the concept of a project. There are two types of projects,
overlay projects and layout projects.

1.3.1 Overlay projects

Use overlay projects if you are using Infoprint Designer to create overlays that will
be used with other formatting solutions, such as DDS or Advanced Print Utility.
You may also use overlay projects to work on overlays that are used in many
different layout projects, or just to have a clean slate while the initial design work
is being done. The project file, with suffix *.prj, for an overlay project will contain
the name of the overlay(s) and a pointer to the default library profile document.

Figure 1 shows an example of the panel you will see when you start a new
overlay definition (that is, an overlay project). The default name of the project will
be UNTITL (for “untitled”). Do not save it under this name - you should
immediately change that to a meaningful name of your own choice. When you
change the project name it will also automatically change the name of the overlay
file. You may add additional existing overlays to your project when you start it by
clicking on the Append button.
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Figure 1. Starting an overlay project

1.3.2 Layout project
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When you start mapping application data onto your overlay you need to switch to
using the Layout Editor. (This is described in 1.7, “Layout Editor” on page 14).
Your work here is saved into a layout project. You can also start directly with a
layout project. As before, you are not permitted to save the file under the default
name of UNTITL, so change the name of the project to a meaningful name of
your choice. When you change the name of the project, it will automatically
change the name of the layout file. This name will become the name of the AFP
page and form definition objects that will be created. (See 1.8, “Introduction to
form and page definitions” on page 20).

At this time you may also choose to associate a line data file from either the
AS/400 or your PC to your project. This is the sample file of data you work with,
and is described in 1.7.1, “Selecting sample data from the iSeries server” on
page 14.

Figure 2 on page 7 shows an example of the New Project options for a layout
project.
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Figure 2. Starting a layout project

The project file for a layout project contains references to the sample spooled file
used to create the project along with the name of the layout source file and a
pointer to the library profile.

Typically, an Infoprint Designer project will correspond to your application, for
example Invoices, Purchase Orders, Statements and so on. Depending on the
design of your application, however, a project might encompass two or more
applications. For example you might include the ability to determine whether an
invoice is actually a credit note and invoke the appropriate overlay and page
layout.

1.4 Designing and creating an overlay

By default Infoprint Designer begins with a screen labelled “View/Edit". This is
your workspace. The reason for the screen title is that if you are editing your page
layout you can also view the overlay “behind” the data - and vice-versa. See

Figure 3.
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Figure 3. Initial Infoprint Designer View/Edit screen

Notice that the selected (middle) tab is called “UNTITL” i.e. an untitled overlay.
We also have the opportunity to start work on another overlay - by clicking on the

Chapter 1. Advanced use of IBM Infoprint Designer for iSeries 7
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“New overlay” tab, or begin work on the document layout (i.e. mapped data and
overlays) by clicking on the “Layout” tab.

1.4.1 Saving your work

1.4.2 File names

8
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Infoprint Designer auto-saves your project file by default every 2 minutes. This
can be adjusted using Edit->Preferences->General. You will also be prompted
to save the overlay and layout source separately if you attempt to close or quit the
current project. The prompt asks if you will save an “ogl” file. OGL stands for
Overlay Generation Language, an IBM mainframe program product used for
creating overlays. Note that you cannot upload and use the OGL source file
independently from Infoprint Designer - the program licence is for use only as an
iSeries product. However the actual AFP resource objects you create - overlays,
page segments, etc. may be transferred to and used with other AFP systems.

It is necessary only to save the Project file (this saves the layout and overlay
definitions), but you may find it useful to save the individual component files
separately for use with another project. For example your Statement project file
may contain two overlay files (say Stmnt.ogl and Terms.ogl). The Terms and
Conditions overlay (Terms.ogl) might be used with another application i.e.
another project. You might choose to store it under a different name or in a
different location.

The Save and Save As panels are similar to the panels shown in Figure 1 on
page 6 and Figure 2 on page 7.

To save your work, click File->Save project as... Then highlight the Overlay line
and click Save as. Type in a new overlay file name, and navigate to a preferred
path if necessary, then click Save. If the path and file name are already correct,
clicking Save will simply update the overlay file with your latest changes to the
overlay.

Even though Windows and Infoprint Designer permit long file names for project
names it may be advisable to save the various files using a 8-character maximum.
This is enforced for the save of overlay source files in any case. Layout files will
be truncated to 8 characters on upload to the iSeries system (for example
NEWSTATEMENTS.PFA will be truncated to NEWSTATE).

If you are producing AFP resources for use with other non-iSeries systems you
might restrict filenames to six characters. The reason for this is because on some
IBM platforms AFP source code is compiled to produce resources beginning with
specific prefixes, namely P1 for a page definition, F1 for a form definition, O1 for
an overlay and S1 for a page segment. For example, a layout file NEWSTA would
produce page and form definition objects called PAINEWSTA and FINEWSTA.

Unless you know that you will be using your overlay and page segment resources
with a product such as PPFA/400 (which does use the prefixed naming
conventions), or have previously adopted that naming convention, we recommend
you do not use the prefixed naming conventions. To do this, access
Edit->Preferences->AS/400 and ensure that the check marks from the four
“Prefix” boxes are removed, as shown in Figure 4 on page 9. This is the default
setting - all this means is that your resources will not be prefixed with “O1”, “F1”
and so on.



Draft Document for Review December 9, 2001 1:52 pm 6250ch07.fm

Profermsce_ S 1kl
o e irmgm cpiors | i |
G | e | unkz e ALMDE
Horl namm; |H| a8 T "'|
Litrary: smon [
Ukt 102 {HIRADM Connec
Pramwnnd: i".'.'i"'“ - =
finnd
I~ Foaby r In
[+ Page segments F Rsplais
Prefix
™ 01 - wwarisys ™ 1 - angmsnin
T F1 -t defa. ™ PN - paje dela.
o] e ||

Figure 4. Recommended configuration for resource names and send options

A last point on filenames is that a Project file (*.PRJ) can have a long file name,
such as “Project to construct new statements application.pfa”. This name will be
retained in Windows, although only the first 43 characters are displayed in the
title bar of the Infoprint Designer window and you lose the *.prj suffix, and the
selected host printer resolution (for example 300 ppi). To keep this information on
display, restrict your project names to 29 characters in length - or use the same
name as that of the Layout and Overlay definitions!

1.4.3 Importing existing electronic overlays
If you have existing AFP overlays, you can convert these for use directly with
Infoprint Designer. The procedure first depends on which method you use to get
the overlay file to your PC.

1.4.3.1 Using file transfer

You need to use the CVTOVLPFM command provided with AFP Utilities/400
(5769-AF1 or 5722-AF1) to convert the overlay object into a physical file member
then transfer the file to the PC, using a suitable method such as FTP or Client
Access/400 file transfer, in binary in both cases. (You cannot use the original AFP
Utilities/400 source file).

1.4.3.2 Using a mapped network drive
With this method, use the OS/400 CL command CPYTOPCD to copy the overlay
object to a suitable folder on the iSeries. For example:

CPYTCPCD FROMFI LE(SI MIN' | PD) TCFLR(DESI GNER) FROWVBR( | \VO CB)
TCDOQ( | \VO CE. ALY) REPLACE(*NO TRNTBL(* NONE)

Now create a share to this folder using Windows (My Computer - Tools - Map
Network Drive, enter a drive letter and the path to the folder, for example
\\WMYAS400\DESIGNER). You can then copy the overlay object to your PC or
access it directly from the network drive.

1.4.3.3 Using AFP Manager
AFP Manager is an addition to the Client Access Operations Navigator interface.
It is described in it's own chapter elsewhere in this book.

Chapter 1. Advanced use of IBM Infoprint Designer for iSeries 9
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1.4.3.4 Using a Java program
An alternative method is shown in the Java program in the Appendix “Extracting
AFP Resource contents”.

Once you have the AFP overlay file on your PC, select File->Get overlay from
within Infoprint Designer. The suffix is significant only for filtering the display of
available files. See Figure 5. Before allowing you to work with the overlay,
Infoprint Designer prompts you to save it as an *.OGL source file. Infoprint
Designer will then import the overlay into your current overlay editor screen,
where you may work with it as normal.

1.4.3.5 Limitations

This method works best with simple overlays of lines and boxes. Text that was
originally separate items may now be in a large group of words. This is
unavoidable because of the way the text is stored in the AFP overlay. Additionally,
although overlays created with font character set and code pages may be
imported, these fonts are mapped to coded fonts with code page 500, which may
not provide the results you want. In the worst case, you may have to delete and/or
recreate just the text blocks if changes are needed. Also note that page segments
referenced in the overlay need to be brought down separately and stored in the
appropriate page segment libraries identified in the Designer’s library profile.
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Figure 5. Importing an AFP overlay object

If you previously created an overlay using Infoprint Designer you have the overlay
source saved as a *.OGL file (typically in the OGL directory of your Infoprint
Designer installation directory). You can also open this for use with a new design:
select File - Get overlay as before. Figure 6 shows the results of opening an
existing overlay called INVOIC.

10  iSeries 400 Printing VI
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Figure 6. Opening an existing Infoprint Designer overlay

You can delete overlay(s) from your current project by using Edit - Overlay list to
select the appropriate overlay and click on Delete. Note that you can also swap
out the overlay for another one, by using the Change button in the same menu

dialog.

1.4.4 Converting pre-printed forms

Another approach to the above method is to make a good-quality scan of a
printed copy of your existing AFP overlay, or even use an existing pre-printed
form. Setup your scanning program with the following options:

* TIFF format
* Bi-level (black and white)

« Resolution to match that of your target printer (probably 300 dpi, but possibly
also 240 or 600 dpi)

» Scan the image at actual size (1:1)

Infoprint Designer refers to a scanned image of this type as a Template. To import
it, use File - Get template. Browse for the TIFF image on your PC and select it.
The scanned image appears as a non-editable “background” image. You can now
trace over the existing elements (boxes, lines or text) to create your new overlay,
and also add new elements. The template will not print nor appear with your new
overlay. When you have finished using the template you can select File - Get
template - and click on the Delete Template button.

You can also use overlay source files and overlay objects with the Get template
command. The overlay is presented as a greyed-out image as before. The effect
is the same as if you loaded (Get overlay) an overlay into the project, but as the
template overlay will not be saved with the project, this approach may be easier if

Chapter 1. Advanced use of IBM Infoprint Designer for iSeries 11
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your project contains many overlays and you need another for reference or for
tracing.

1.5 Miscellaneous hints and tips

Most of these tips also apply to the Image and Layout Editors but you are perhaps
more likely to use them while constructing overlays.

1.5.1 Using the grid

You can create very accurate overlays with the assistance of the grid feature.
Select Edit->Preferences->Units and Grid. Then set up the grid to your
preferences. Notice that this only covers the grid dimensions and characteristics.
Use View->Grid to enable the display of the grid (or Ctrl-G) and View-Snap to
Grid to enable grid snapping. The latter term refers to the automatic alignment of
your overlay or page elements to the grid, for example if you draw a box
beginning at 0.48” across the page and grid snapping is on with a grid at 0.5”
increments, the box will be left-aligned at 0.5”. We recommend you keep grid
snapping on and only occasionally switch it off for fine adjustment of individual
elements.

1.5.2 Use the right-hand mouse button

Use the right-hand mouse button (RMB) frequently. For example, with no
elements selected, selecting the RMB in the View/Edit window will bring up a
menu controlling zoom in/out, the ability to fit your view to the page width or
height and the Refresh facility. The latter refreshes your display and this is
sometimes necessary when you have just drawn a more complex series of
elements. How often you need to use Refresh depends on the performance of
your PC and its graphics adapter.

If you do have an element selected, use of the RMB will bring up all the
parameters that may be edited for that element. Edit->Object properties is the
equivalent menu bar function. The keyboard shortcut is Ctrl-E.

1.5.3 Use the Shift key
Using the Shift key permits multiple elements to be selected. For example, select
several text fields in a document. Select Edit - Object Properties. A small box with
the options COLOR, TEXT PAR and ALIGN will appear. The chosen change will
be applied to all three elements.

1.5.4 Use the Ctrl key

Using the Ctrl (Control) key while using the normal mouse key often invokes
additional functions. For example, the “tear-off” function: select an element, hold
the Ctrl key down and drag a copy of that element elsewhere on the page.

In Layout mode, this latter description is useful for adjusting the line spacing of all
fields in a repeated printline: select any but the first field, hold the Ctrl key down
and drag the fields to a new line spacing interval.

12  iSeries 400 Printing VI
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1.6 Using the Image Editor

Most users of Infoprint Designer require image data in their application. Examples
of this could be a corporate logo, a signature, or an industry membership sign.
Generally these exist somewhere in the company in one of the common PC
formats such as BMP, GIF, JPEG or TIFF. If they do not, they may be scanned in
and converted to one of these formats.

Like most image-editing tools, Image Editor allows you to touch-up and/or
enhance the quality of the scanned or imported image. However the Image Editor
goes on to convert these PC file formats to AFP format, allowing you to work
natively with the AFP object at the PC graphic design level. Specifically, it creates
an AFP page segment, which will be uploaded to the AS/400 when the project is
uploaded. At any time the image may be imported into the AFP overlay.

1.6.1 Creating separate AFP page segments

Your requirements for an overlay may be fairly simple, for example the company
logo plus the address and contact details of its offices. In this case, select File -
Get image to incorporate the company logo as part of the AFP overlay. Anytime
you print that overlay, the same logo will print with it.

On the other hand, there may be times when you wish to use a page segment
independantly of any overlays being used. Examples of this are:
« different signatures used on a check depending on the value of the check

¢ using one constant overlay shell where you change the company logo based
on some condition in the application

« variable positioning of the page segment using other tools such as DDS

Tip
Even if a page segment is not going to appear on an overlay in your
application, you may choose to create a dummy overlay project and add the
page segment(s) to it. That way it wil be easy to upload the page segments to
the iSeries. It will also help with testing.

1.6.2 Using the Image Editor

Image Editor is a relatively straightforward graphical design tool and with features
such as on-line context-sensitive help and floating “bubble help” for the icons, the
best way to learn it’s features is simply to start using it. However there are some
important points that should be noted.

1.6.2.1 Print resolution of resources

You should set the resolution of the resulting AFP image to match that of your
target printer. Typically this will be 300 pel (picture elements per inch, also
referred to as 300 dpi, dots per inch). Note that even though your target printer
prints at 600 pels, as far as PSF is concerned, the resolution is likely to be either
240 or 300 pels. For example printers such as the IBM Infoprint 20 usually print at
600 pels but the resources sent to them will be either 240 or 300 pels. Printers
such as the IBM Infoprint 70 do have the ability to receive 600 pel resources
directly but for portability, 300 pel should be sufficient.

Chapter 1. Advanced use of IBM Infoprint Designer for iSeries 13
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1.6.2.2 Print orientation of resources

AFP images are known as page segments; they are individual segments of a
logical page, and may contain their own characteristics, different from that of the
rest of the page. The most important of these is the orientation of the page
segment - if created at zero degrees rotation, it will always print at zero degrees
orientation, even if the rest of the document and overlay are rotated. Therefore it
is common to produce at least two versions of each page segment, one at 0
degrees, the other at 90 degrees, together with a suitable naming convention
such as LOGO and LOGO90.

1.6.2.3 Creating page segments

If your image exists in a color form, try to obtain a black and white version before
converting it to a page segment. If this is not possible, dither the logo first. Select
Image - Dither, then select Color B/W or Greyscale. The best choice may
require some experimentation. Remember to use Edit - Undo (or Ctrl-Z) if you
don’t get satisfactory results the first time.

Having converted it, you need to select File - Save as. Save it as an AFP image
(page segment) with a suffix of *.PSG. You will then be prompted for the AFP file
parameters. There are many possible combinations, but a typical selection would
be as shown in Figure 7.

Figure 7. Typical combination of save parameters for an AFP page segment

1.7 Layout Editor

Layout Editor is the tool within Infoprint Designer that you use to design the
complete electronic form, adding your overlays and images to data from your
application. Infoprint Designer can work with either unformatted or formatted
data. Unformatted data is sometimes known as a “flat file” or line data. Formatted
data might have some or all of the data placement already determined, for
example a customer name and address at top left, an invoice total at bottom right.
In either case we can use Infoprint Designer to redesign the page layout without
changing the original application.

1.7.1 Selecting sample data from the iSeries server

The first task is to gather sample data from typical page(s) of our selected
application. Infoprint Designer is tightly integrated with the iSeries server - which
is why the first step in an Infoprint Designer session is to sign on to an iSeries
session. As soon as you click the Layout menu button, you are prompted for the
source of your data. To begin with, it's likely that this will be the iSeries system.

14  iSeries 400 Printing VI
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By selecting the AS/400 radio button you are provided with the list of output
gueues to which you have access on the iSeries server. Then speed up the
search if possible by typing an output queue name that contains your test spooled
file(s). See Figure 8.
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Figure 8. Selection of output queue containing sample data

¥
]

You could scroll through the list of output queues but assuming you know the
name of the queue, enter it and click OK, as in Figure 9.

T T
Tt geeun; ﬁiiii

Hpestaid lles

Han Hslier Jeb nase  Jdob He. lisew name  Date Faqes
WPOEPLIN 1 QFEOEUANTT EITREN  %IHBS IR I R
FFIEEE g OFSDEURADE BATEET  S1HIM ol E3R ]
IMIECS 1] QFADEUAODE Boiils  S1HEM TeNars &
Mumbier ol pages 1o irtieye; |

[ nulj;-nm|| Help |

Figure 9. Selection of a sample spooled file

The next dialog you see is the “Select line data file”. This is actually prompting
you to save the spooled file data locally on your PC. Give it a suitable name and
suffix (for example ASC - Ascii) and save the file. Your View/Edit window remains
blank, apart perhaps from any overlays you have in the background.

Now click on Window - Data and you will see a new window entitled the Data
Window. This contains your unmapped sample spooled file data, blue in color.
Now click on Window - Tile to get the Data Window and the View/Edit window
displayed together. From here you can drag and drop selected areas of text into
the View/Edit window, as described in the Getting Started manual. If you already
have an overlay open, you will notice it is in the background, as in Figure 10 on
page 16.

When you have the windows arranged to your liking, click on Windows -
Arrangement - Save.
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Figure 10. iSeries sample data located, about to start data mapping with Infoprint Designer

1.7.2 Selecting sample data from the PC

16

When using Infoprint Designer you will always be connected to the iSeries server.
However you may later find that the sample spooled file you used for your designs
has been deleted from the system, perhaps through regular spooled file
housekeeping or simply because it was printed! The answer is to use the local
copy stored on your PC, which Infoprint Designer refers to as the “line data file”.

To access this file, select File - Get sample data and select From PC. By default,
Infoprint Designer looks in the \DESIGNER\DATA directory. You can select a file
of type *.ASC (meaning ASCII data) but you can select any text file you have
available. You are then prompted further with Figure 11.
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Figure 11. Line data options when importing a sample spooled file from the PC

The default values in this screen are taken from the original downloaded spooled
file attributes. Therefore you should leave all or most values as they are but the
following notes may be of help.
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1.7.2.1 Code page

The code page should match the code page Windows is using on your PC.
Typically this is 437 (MS-DOS Latin 1 US) or 850 (MS-DOS Latin 1Multilingual). If
you are not sure which code page your PC is using, type “chcp” at a DOS prompt
to display the active code page. Take care when referring to Windows
documentation: the terms “code page” and “character set” mean the same thing.
This is not the case with the IBM AFP architecture.

1.7.2.2 Record format

Use variable record format with PC spooled files previously derived from the
iSeries (even though the iSeries is a fixed record format system). Also use
variable record format with PC spooled files sourced from IBM mainframe
systems such as OS/390. If you are extracting data from a spreadsheet file, you
might select fixed record with a delimiter such as tabs or commas.

1.7.2.3 Channel type

In this context “channel type” refers to line spacing and page skip controls that
may or may not be in the PC file. A more usual term is carriage control, or in
iSeries parlance, First Character Forms Control (FCFC).

With ANSI encoding, a line space occurs before printing the line. Common ANSI
FCFC characters include a space (write, then perform one line space), + (no
space), 0 (two spaces), - (three spaces) and a 1 (write after skipping to a new
page). The latter case is also known as a “Channel 1”.

Machine encoding means that the data is printed, then any line or page skip
controls are performed, i.e after the data line.

“No channel” means that no spacing or skip controls are present in the file. If this
is the case, you have a true “flat file” of data and the file is unlikely to be a
spooled file but perhaps imported from another source such as a spreadsheet or
data file.

ANSI line spacing control is the most common channel type on the iSeries
platform and if your spooled file originated on the iSeries, this is the most likely
choice for your PC file.

1.7.2.4 Page length and width

Leave these at their default setting (i.e. as inherited from the iSeries spooled file).
The page length is especially important as this dictates how many records (lines)
will be available for mapping on each page of output.

1.7.3 Mapping data to the layout

Once you have successfully loaded the sample data into your project you can
start mapping individual fields or groups of fields. You do this by highlighting the
area you wish to select from within the Data Window, using the left mouse button,
and then dragging it using the right mouse button.

It is a good idea to have the documentation for the application you are working on
available. The data you see on the sample page you are looking at may not
represent the full length of the fields. For example, in the Invoice example in
Infoprint Designer, the original programmer’s DDS code (not included) showed
that the field NAME is placed at position 12 on the line, and is 25 characters long.
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You can verify you have the correct position and length of field by watching the
information displayed at the top of the Data Window as you are highlighting the
area. If you don’t have access to this information, you must ensure you test your
new print application with as wide a variety of sample data as possible.

When you first bring in the data, the first logical page will be represented in the
Data Window in blue. Subsequent pages will be in red. All the field mappings that
you perform should be selected from a blue page. If you need to bring up a
different page of the data, use the Next button (just below the menu items) to
page through the available data.

Once you have the field placed on the View/Edit window, you can make some
further modifications to it. Right click on the field to see the Field Properties
window. From the General tab, you can verify the positions from the original input
record, and field length against your application documentation. Click on any of
the other tabs to change the characteristics of the field, such as font or
orientation. Figure 12 shows an example of mapping a field and modifying its
properties. Note the entries at the top bar of the Data Window showing that we
have selected Record 12, Field 12-36.
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Figure 12. Mapping and modifying a field
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If a column of fields is to have similar characteristics you can select the entire
area and them map them in one step. Figure 13 shows the results of highlighting
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and mapping a column. The fields will remain logically grouped together in your
design, so you can move them or change other characteristics en mass.
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Figure 13. Mapping a column of fields

If you want to make group changes, left click on just the first element of the group,
and then either drag it to a new position or right click to change other
characteristics. If you wish to change the interline spacing of a group of fields,
click on any field in the group, other than the first, and drag it up or down until the
column is arranged to your liking.

You may notice that the information bar at the top of the screen shows slightly
different information, depending on which field you select. If you select the top
field you see the absolute position at which it is mapped. If you select other fields,
you see the relative positions.

If you have multiple columns of data in a section, you can adjust the line spacing
of all the columns at one time. Click on one of the fields in one of the columns and
hold the Ctrl key while you adjust the line spacing. All the other columns that use
the same range of lines will be adjusted accordingly. This action will synchronize
the interline spacing. You have to manually ensure that the first entries in the
group are aligned.
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Note

It is possible to ungroup a set of fields, using the Ungroup Printline icon from
the toolbar. Use this with caution. Once you have done so you cannot easily
regroup the fields.

Continue mapping all the required fields from the Data Window to the View/Edit
window. You may find it easier to do the mapping on a gross level first, just
dragging and dropping the required fields over to their approximate destination
View/Edit window. Then close down the Data Window and enlarge the View/Edit
window to fine tune the positions and make other changes to the field properties.

As a final test, you may want to open both the View/Edit and the Data Window
and page through all the available data pages to make sure you have captured
everything you need.

1.8 Introduction to form and page definitions

Underneath the covers, Infoprint Designer builds two very important AFP
resource objects called a form definition and a page definition.

A form definition is concerned with physical entities such as simplex/duplex, print
quality, paper source drawer, and also the position of the logical page on the
physical piece of paper. A page definition defines the appearance of the logical
page of data, for example the position of the text, the fonts, any overlays, the
page orientation and so on.

Note that these two formatting controls are application-independent. With the
addition of the easy-to-use Infoprint Designer GUI, document presentation
changes need no longer involve the iSeries application programmer.

For basic use of Infoprint Designer it is unnecessary to take note of the above
information. However for more advanced use it is very useful to have an
understanding of how page and form definitions interact to build the final
electronic document. We look at several areas which make closer reference to
the concept.

1.8.1 Form definition components

A form definition specifies how the printer controls the processing of the physical
sheets of paper. Within a form definition you specify functions such as duplex,
overlays, copies, suppression, jogging (offset stacking), paper source, constant
pages, multi-up, finishing.

The form definition has two important subdivisions: copy group(s) and
subgroup(s).

1.8.1.1 Copy group

A copy group defines the current physical page within a form definition. Note that
it defines the physical page and could therefore include the formatting
instructions for two sides of a piece of paper. A form definition might contain only
one copy group. If a different copy group is invoked, it follows that printing must
start on a new physical page. An alias for copy group is medium map.

20  iSeries 400 Printing VI



Draft Document for Review December 9, 2001 1:52 pm 6250ch07.fm

Common purposes for a copy group include the ability to pick from a different

drawer on the printer. Another example is a switch between simplex and duplex. A
final example is the printing of an overlay of standard terms and conditions on the
reverse side of client copies of a purchase order. Switching between copy groups
in the form definition is controlled by conditional processing in the page definition.

1.8.1.2 Subgroup

A subgroup is a subset of a copy group. Up to 127 subgroups can be constructed
within any one copy group. The easiest way to remember the function of the
subgroup is to think of multipart stationery (top copy, pink copy, blue copy, etc.),
as commonly used on impact printers. To replicate this electronically we can use
multiple subgroups to repeat each printed page as required. The difference is that
each copy may be altered subtly if required.

For a duplexed sheet of paper, there will be a subgroup for each side.

1.8.1.3 Form definition logic tree

Infoprint Designer uses a logic tree structure to represent the form definition
being used in the layout. To display or work on the form definition tree select
Layout mode from the View/Edit window, and then select Window - Form
definition from the main menu. From the form definitions window you can easily
add copy groups, subgroups, or overlays to your design, or change their
properties. Figure 14 shows an example of a very basic layout.

‘ﬂ \

RESIC
— o
o O —

e

Figure 14. Basic form definition tree

In this example, we have a form definition named BASIC. Within it we have one
copy group, COPY1. Having only the one copy group means that all pages of data
will print using the same media. Within the copy group we have one subgroup,
SUBGROUPL1. With only one subgroup defined, the resulting output will only
generate one copy of each page. The selection of the overlay(s) to be printed on
every page is defined within the subgroup, in this case we are using INVOIC, the
Super Sun Seeds Invoice.

1.8.2 Page definition components

The page definition specifies how you want data positioned on the logical page.
The primary purpose is to map each line of input data to a position on the
formatted page. You may change the fonts of a field, rotation, interline spacing,
turn it into a bar code, or indicate that you want to suppress printing. Page
segments and overlays may be defined within a page definition. There are
controls in the page definition to control multiple-up printing. Finally, the
conditional processing logic to switch between different page formats and/or copy
groups is defined in the page definition.

The page definition must contain at least one page format.
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1.8.2.1 Page format

Another name for the page format is a data map. This is a less common term but
the name may help you to remember that the data map or page format maps
data onto a page. Different page formats will result in different page layouts. For
example, you may wish to lay out the data of a detail page of a report differently
from the cover page or the final summary.

Typically, different page formats are selected by “trigger fields” in the application
data. The trigger fields could be anything you like, as long as they are in a
predictable position in the original application data. Testing of these fields is done
in the page definition itself. Switching between different page formats is another
example of conditional processing.

1.8.2.2 Subpage

All page formats generated with Infoprint Designer contain at least one subpage.
It is within the subpage that the actual data mapping takes place. Multiple
subpages within a single page format allow you to place multiple logical pages on
one physical page.

Subpages are also used in controlling the timing of when a switch takes place in
conditional processing. This may be seen in the condition definition window (see
Figure 26, “When condition” on page 32 and Figure 27, “Otherwise condition” on
page 33). See also Section 1.12.3, “Advanced conditional processing” on

page 34.

1.8.2.3 Printline

Printline is the instruction within a subpage that is essentially used to define what
to do with each line of data in the input file. It is possible to group similar
information, such as the detail lines in the body of a report, using the repeat
function. An entire line may be formatted using printline, or it may be split into
individual fields. Page segments or overlays may be associated with a printline.
Conditional processing instructions are associated with specific printlines.
Printlines may be selected based on a channel code which may be in position 1
of the data. The most common instance of channel code is a “1” being used to
indicate a new page. Subsequent printline commands are processed in
sequence. For more information on channel codes see Section 1.7.2.3, “Channel
type” on page 17.

1.8.2.4 Fields

Individual strings from the input data may be formatted independently of the rest
of the line. For each field you can define its font, location, suppression,
orientation, or whether to print it as a bar code.

1.8.2.5 Page definition tree
Infoprint Designer uses a tree structure to illustrate the page definition being used
in your layout. An example of a basic layout is shown in Figure 15.
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Figure 15. Basic page definition

In this example, we have a page definition named BASIC. Within it we have one
page format, PAGE1. Having only the one page format means that all pages of
the input file will be mapped the same way, using the same fonts, etc. There is
one subpage, SUBPAGE1, which means that we will be printing one logical page
per physical page.

The first printline instruction, [R1] is triggered when channel 1 is encountered in
the data, as indicated by CH1. The next eleven data records are processed
individually in sequence. (The field mappings have been collapsed, as indicated
by the “+”.) Records 13-15 are all to be handled using the same rules, as
indicated by [R13-15]. In this case a field consisting of characters 1-80, [F1-80]
was mapped by default by Infoprint Designer to be suppressed. Then, as part of
the act of creating the design, a field, [F12-25] consisting of characters 12-25
were placed on the page in a specific location with a specific font, as were
characters 48-61, [F48-61].

1.8.3 Infoprint Designer and suppression

When you start a new Infoprint Designer session a default layout is created, even
before you do any field mapping. The form definition that is created contains one
copy group which in turn contains one subgroup. It you started the project with an
overlay definition it will have the default overlay mapped into the subgroup. The
subgroup will have suppression set with the name DFLT as shown in Figure 16,
“Subgroup with DFLT suppression” on page 24. This means that any fields
defined in the page definition with the Suppression subcommand set to DFLT will
not print.
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Figure 16. Subgroup with DFLT suppression

To see the details of the subgroup, or any other item in a form definition or page
definition logic tree click on the item with your right mouse button.

The page definition will have one page map, and one subpage. As soon as you
bring in the sample data, Infoprint Designer will create one printline for each line
in the sample data page. Each printline will have one field defined corresponding
to the length of the data. Each field will have suppression set to DFLT, as shown
in Figure 17. To see the suppression settings on a field, first right click on that
field in the page definition logic tree, and then left click on the Suppress button.
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Figure 17. Field with DFLT suppression

Essentially, Infoprint Designer has created a layout that maps the entire page, but
suppresses it all at the same time. If you are only doing single page mapping this
may not concern you, but if you are using some of the more advanced techniques
such as conditional processing, copy groups, or subgroubs you will need to
understand what is happening.

First some background. The basic layout technique of page definition is to
describe how each line is to be handled in sequence. For example, do something
with line one, do something else with line 2 and repeat it 5 times, and then do
something yet again with line 7. If you didn’t want to do anything with line 8 of the
input file, you have to explicitly inhibit it, usually using suppression. If you do not,
the next instruction that you intended for line 9, is used against line 8.

When you use Infoprint Designer to map fields, you only need to drag and map
the fields you want to use. So if you want to print the address that starts on line
12 of the input data, you only need to drag that line across. Infoprint Designer has
already taken care of lines 1 through 11 by suppressing them for you.
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If you create a new subgroup, make sure you specify the DFLT suppression on it.
Otherwise, you will end up with two mappings of your data field: the ones that you
intended, plus the ones that are supposed to be suppressed. Figure 18 shows an
example of what you may see if you forget to do that.
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Figure 18. Example of double mapping

A way of perhaps avoiding this is to take copies of a subgroup, rather than create
a new one. The fast way to do this is by displaying the form definition window
(Window - Form definition), then selecting the subgroup, hold the Ctrl key down
and drag the subgroup to just below its original position. Release the mouse
button and a second subgroup is created. This method is used frequently in the
following examples.

1.9 Introduction to advanced examples

In the following few sections we will be describing step by step instructions on
using advanced form and page definition features to enhance your applications.
See:

e Section 1.10, “Using subgroups” on page 25

e Section 1.11, “Adding a constant back to a subgroup” on page 29
e Section 1.12, “Using conditional processing” on page 30

e Section 1.13, “Constant text in the layout” on page 35

e Section 1.14, “Creating a landscape project” on page 35

e Section 1.15, “Multi-up bar code labels” on page 45

Sample projects have been included with your copy of Infoprint Designer for
iSeries. These examples are based on some of those samples. You may wish to
copy the samples and try making the same changes as described below. For a
complete list of the available samples and the features they demonstrate see the
Appendix “Infoprint Designer for iSeries projects”.

1.10 Using subgroups

When migrating an application from multipart impact printing to laser, one of the
first things you may want to do is use Infoprint Designer to create multiple copies
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of the pages in your spooled file. This is easily done by defining multiple
subgroups within one copy group. The copies do not have to be exactly the same.
Each subgroup could have different overlays associated with it. Paper may be
selected from different bins, allowing you to select different-colored paper for
example. Finally, you may have a different set of suppressions set up within the
different subgroups. For example, it is common practice not to print the prices on
a packing slip. Alternatively there may be information on the internal copy (such
as accounting information) that you would rather not have printed on the client

copy.

Note

When designing multiple copies of a page using subgroups, be aware that the
data mapping of each copy will be the same. The only difference is that it is
possible to suppress different combinations of fields on the different copies.

1.10.1 Packing slip example

This example assumes that the design and mapping for an invoice page has
already been completed. This corresponds to the sample project basic.prj. Now
we wish to modify the design to add a second copy of page using a different
overlay, different paper source, and suppression on the price fields. The sample
project twocpy.prj reflects these changes. The steps you need to take to
accomplish this are as follows:

1. Open up the original invoice project on which you wish to base the new
project.

2. Itis probably a good idea to immediately do a File -> Save project as so that
your new work will not affect the original project. On the Save project as
dialog, change the name of the project file and the layout file. Click OK. The
form definition and page definition will take on the new name.

3. Open up the Form Definitions window. You will see the existing logic tree with
one copy group, one subgroup and the invoice overlay. We want to add a
second subgroup to this definition. The first thing to do is to copy the original
subgroup. While holding the Ctrl key, left click on the icon for the subgroup. A
slightly larger icon will appear with a red cross through it. Holding down the
mouse button move the new icon down so it is just below the original icon. The
red cross should disappear. Release the mouse button. Infoprint Designer will
have created a new subgroup on the logic tree, exactly the same as the
original one, and just below it.

If you wanted a brand new subgroup that wasn’t to be a copy of the existing
one you could drag down the Subgroup icon from the toolbar. Remember to
add the DFLT suppression any time you create a new subgroup.

4. We can now modify the new subgroup. If you copied the original subgroup, the
new one will have the Invoice overlay associated with it. Click on the icon for
the invoice overlay within the new subgroup and press the Delete key. Now we
want to add in the packing slip overlay. (Assuming that you have created it
earlier). Click on the overlay icon on the tool bar, and drag it down to the new
subgroup.

26  iSeries 400 Printing VI



Draft Document for Review December 9, 2001 1:52 pm 6250ch07.fm

5. You will now be presented with an Open dialog box. Select the desired overlay
(PACK in this case).

6. Now we want to change some of the other characteristics of the new
subgroup. Right click on the icon for the subgroup. The Edit subgroup dialog
will be displayed, as shown in Figure 19. We want to create a suppression tag
so that the price fields do not print. Put the cursor in the entry field under the
Suppression heading and type the name of the tag which will be used on the
price fields. In this example we will use PACK. Click on the Define button and
the tag will be moved to the larger box below. The DFLT suppression should
be listed there already. If not, add it in.

Now we can add a meaningful comment, and change the paper source to Bin
2. Press OK when the changes are complete.
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Figure 19. Edit subgroup

7. We now need to modify the price fields in the page definition so that the PACK
suppression prevents them from printing on the packing slip. Activate the
View/Edit window. Select the first field in the price column and right click on it
to bring up the Field properties dialog, as shown in Figure 20.
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Figure 20. Field properties

Click on the Suppress button to display the Field Suppression dialog as
shown in Figure 21 on page 28. You will see a list of suppression tags that
have been defined in your subgroup. Click on PACK to activate it for this
column of fields.
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Repeat this process for any other columns or individual fields you wish to
suppress.

8. Before you complete your project, it is a good idea to check that you have set
up the suppression correctly. Open up both the View/Edit window, and the
Form definition window. Activate the new Packing Slip copy group by clicking
on it on the Form definition window. Then click on a blank part of the View/Edit
window. The data will be reloaded, and you should see the packing slip
overlay with the description fields, but not the prices. Your screen should look
something like Figure 22.
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Figure 22. Verifying subgroup

9. Once you are satisfied that your design is complete, save your work and
upload it to the iSeries. Remember, that in order for bin selection to be
controlled by the new form definition, you must specify DRAWER(*FORMDF)
on the printer file. This is covered in 1.16.4, “Duplex and drawer selection” on
page 52.



Draft Document for Review December 9, 2001 1:52 pm 6250ch07.fm

1.11 Adding a constant back to a subgroup

1.11.1 Example of

It is common practice to print a “Terms and Conditions” page on the back of a
document such as a company invoice or statement. With subgroup processing we
can do this using a function called Constant Back. This is a useful feature of form
definition processing; without this, the application would need to track what pages
were to be printed in simplex and what pages in duplex, and insert a blank page
at the appropriate points.

We need to set up the copy group for duplex printing and tell it we want to use a
constant back. Then we define a pair of subgroups for each copy of our
document, one for the front and one for the back, each with the appropriate
overlay defined.

constant back

Following the previous example, from 1.10.1, “Packing slip example” on page 26,
assume we already have a project created that prints two copies of every page,
an Invoice and a Packing slip. The sample project twocpy.prj has these
characteristics. The copies are slightly different, as they draw from different bins,
use different overlays and suppression of prices is in place on the packing slip.
Assume we wish to add a Terms and Conditions overlay, TERMS, to the Invoice
copy only. This overlay already exists. We will leave the back of the packing slip
blank. The sample project back2.prj reflects these changes.

1. We will start by making the necessary modifications to the copy group,
COPY1. Activate the form definition window, and right click on the copy group.
Click on the Duplex tab. You will see a window similar to Figure 23.
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Figure 23. Constant back settings in copy group

Click on the Duplex drop down window and change it to Normal. Then click
on the Back radio button in the Constant box. Press OK.

2. Now we need to set up the subgroups. Start by dragging the subgroup icon
from the tool bar to just below the original invoice subgroup. Repeat and place
a new subgroup below the packing slip.

3. You should have four subgroups now. Right click on the Invoice subgroup. For
the Side option select the Front radio button. The window should look like
Figure 24 on page 30. Click on OK.
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Figure 24. Subgroup specifying front side only

4.

Repeat this step for the packing slip subgroup, making it active for the front
side only as well.

Now right click on each of the two new subgroups, and make them active on
the Back side only. Add descriptive comments.

. Finally, add the TERMS overlay to the subgroup that is on the back of the

invoice. To do this drag the Overlay icon from the toolbar to the terms and
conditions subgroup. Select the TERMS overlay from the Open dialog box.

. When you are done making all these modifications, your Form Definition

window should look something like Figure 25. Note the value of comments and
a good naming convention.
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Figure 25. Form definition with constant back

8.

Save your completed work and upload it to the iSeries. Remember, that in
order for bin and duplex selection to be controlled by the new form definition,
you must specify DRAWER(*FORMDF) and DUPLEX(*FORMDF) on the
printer file (covered in 1.16.4, “Duplex and drawer selection” on page 52).

1.12 Using conditional processing

30
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It is by using conditional processing that electronic documents start to change
from being direct replacements for pre-printed forms to highly-variable,
customized print applications that react to the data within them. Individual pages
within the document may be automatically tailored to specific functions (invoice or
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credit note?) or individual customers (valued or delinquent?) or specific pages
within a set, such as the final page of an invoice versus the other pages.

1.12.1 Concepts of conditional processing

1.12.2 Example of

Conditional processing may be defined as “use of print data to control the
appearance of the final print output”. In the page definition you define a field and
a comparison test to do on it. You can compare the field against a constant, or
check to see if it changed from the previous instance. Based on the results of the
test you can tell Infoprint Designer to use a different copy group, and/or a different
page format.

Conditional processing may also be used to force a new piece of paper in a
duplex environment, or force a new side in a multi-up job.

It is also possible to control when the change is to take place. Should Infoprint
Designer finish the line or subpage it is on before making the change, or restart
the line or subpage with the new layout?

In the example in 1.12.2, “Example of simple conditional processing” on page 31
we will use a fairly simple example of conditional processing. For a detailed
explanation of how to use all of the features of conditional processing please refer
to IBM Page Printer Formatting Aid: User’s Guide, S544-5284.

simple conditional processing

We will look at the Super Sun Seeds invoice as an example of conditional
processing. On the last page of each invoice a “Thank You” message is printed at
the end of the item list. We wish to bring more attention to that message by
changing the font and moving it down the page to the blank space at the bottom.

We can identify the last page because the content of the “Total due” box is
different. On the last page it contains the amount that is due. On earlier pages of
a multi-page invoice, the word “Continued” prints in that box. We will take
advantage of this to set up our conditional processing trigger.

Assume that we already have a working design for the invoice, using one page
format. The sample project twocpy.prj was the starting point for this example. The
results are reflected in the project called cond.prj. Here are the steps to create
the new version of the document using conditional processing:

1. Make a copy of the original project and save it under a different name.

2. It will probably be easiest to work on this project if you have both the
View/Edit window and the Page definition window open. In the page
definition window, you should see one page format with one subpage. It might
be easier at this step if you collapse the subpage tree if it is expanded. You
can do this by double clicking on the icon.

3. The first thing you need for this application is two different page formats. Hold
the Ctrl key down, and using the right mouse button click on the existing page
format and drag it down until you can place a new copy below it in the logic
tree. You should now have two identical page formats in your logic tree. Right
click on the first and change its name to TOTAL. Change the name of the other
one to CONTD for Continued.

Chapter 1. Advanced use of IBM Infoprint Designer for iSeries 31



6250ch07.fm

32  iSeries 400 Printing VI

Draft Document for Review December 9, 2001 1:52 pm

. Assume we do not want to make any changes at this time to the continuation

pages. Left click on the TOTAL page format to activate it, and then left click on
the View/Edit window to refresh the data. You can verify that you have the
correct page format (or copy group) selected at any time as they are displayed
in the title bar of the View/Edit window.

. Make the necessary changes to the field mappings. In the original page

definition you may have had all the description fields in the detailed lines
mapped as one repeating group, of 25 lines. In the new page format we will
only have 16 detail lines. An easy way to change this is to right click on the
first field in the description column to bring up the field properties. Then click
on the Printline properties box. Change the repeat value to 16, and click on
OK twice.

. Now, you are ready to remap the “Thank you message”. If it isn’t already

displayed, open up the Data Window. If the page being displayed does not
have the message, use the Next button in the control bar until a page that
does have it is displayed. Now you can highlight the message information,
drag it to the View/Edit window, and format it as you wish.

. The next step is to add the condition to the page definition. Let us add it first to

the TOTAL page format. Left click on the TOTAL page format to make sure it is
active, and then left click on the View/Edit window to refresh the data.

. In the View/Edit window left click on the field in the Amount Due box. A thin

blue box will appear around the field. Then click on the Condition icon on the
tool bar. The conditional processing dialog will appear. It is a good idea to give
the condition a meaningful name so it will be easy to reference from other
parts of your page definition. We will call it TOTALBOX.

. If the total amount prints in the box, it can start in position 68 if the highest

amount possible prints. However, if the word “Continued” prints, it starts in
position 70. We need to change the Start of the comparison field: entry to
match this. The length to check will be 9.

10.Now we will insert the first part of the condition. Click on the Insert button to

display the Condition definition dialog. The completed dialog will look like
Figure 26.
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Figure 26. When condition

To get to this point, make sure the When radio button is selected, on the left.
In the When box, to the right, select the EQ radio button. This brings up a
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small window in which we can enter the word Continued. In the Then box
select the radio button to Change Layout. We will not be changing the Copy
Group, so that can be left with Curr. (current) selected. Finally, under Page
Format click on the Name radio button and enter the name of the page format,
CONTD. Press OK when all selections are complete to go back to the
Conditional processing dialog.

What we have just done is told Infoprint Designer that when the field in print
line 51, starting in position 70, for a length of 9, equals the string “Continued”,
change the layout so that it uses the page format called CONTD.

11.Click on the Insert button again. In this example, there are only two choices.(a
“Continued” page or a “Total” page). Once the first choice is defined, we can
use the Otherwise function. Click on the Otherwise radio button, and then
make the selections so that the TOTAL page format will be used. Your display
should look like Figure 27.
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Figure 27. Otherwise condition

When your selections are complete, click OK. The Conditional Processing
dialog should now look something like Figure 28.
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Figure 28. Completed condition

12.Make a note of the Printline value. In this case it is R[51]. You will need to
know that in order to set up a similar condition in the CONTD page format. (If
you don’t set up a similar condition in the CONTD page format, once you hit
the condition that takes you from the TOTAL format into the CONTD format,

Chapter 1. Advanced use of IBM Infoprint Designer for iSeries 33



6250ch07.fm Draft Document for Review December 9, 2001 1:52 pm

you will have no way of knowing when it is time to leave the CONTD format
and go back to a TOTAL page). Press OK.

13.Go to the Page definition window, and activate the CONTD page format.

14.Rather than redoing the logic for the condition, we can use the existing
condition as a reference. We are going to associate the copy of the first
condition with the same record. We need to have that record displayed in the
page definition window. An easy way to do that, is to left click in the Amount
Due box in the View/Edit window. Make sure you still have the CONTD format
active. You should see R[51] in the page format window.

15.Click on the Cond. Reference Icon in the toolbar and drag it down to the
R[51] line. When you release the mouse, the Select condition dialog will be
displayed. See Figure 29. You will be shown a list of existing conditions
defined in the page definition. Click on the condition that was created earlier,
TOTALBOX, and click OK.
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Figure 29. Select condition

16.You will now see a tag showing the reference to the TOTALBOX condition
associated with Record [51].

17.You have now completed your conditional processing definition. You can check
your logic by opening the View/Edit window and paging through the data using
the Top and Next buttons on the control bar. The layout of the data should
change as the content of the total box field changes.

18.When everything is completed to your satisfaction, save your work and upload
it to the iSeries.

1.12.3 Advanced conditional processing

These samples just touch on the power of conditional processing available in the
architecture of the page definition. For more information on advanced conditional
processing topics we recommend you refer to the IBM Page Printer Formatting
Aid: User’s Guide, S544-5284.
In that manual you will find information on situations such as:

« Using conditional processing to change copy groups

< Action on a condition at different times:

 before the current line is formatted
 before the current logical page is formatted
- after the current line is formatted

« after the current logical page is formatted

« Using conditions to start a new side or new sheet
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« Using conditions triggered by a change in a value, such as change in invoice
number

* Multi up processing

1.12.3.1 Differences between Infoprint Designer and PPFA

At the time of writing, there are a number of differences between functions
available in the architecture of page and form definitions, and the functions
available using the Infoprint Designer interface. It is possible that further PPFA
functionality could be made available through the Infoprint Designer interface.
However this is not guaranteed.

At time of writing, the following PPFA functions are not supported by Infoprint
Designer (this is not a complete list):

* Record Formatting in the page definition

Table Reference Characters (TRCS)

AFP structured fields within the line data file
PRINTDATA YES/NO subcommand in the PRINTLINE command

* Subcommands pertaining to finishing features such as stapling or z-folding
available on some printers.

1.13 Constant text in the layout

There may be times when you wish to add a small item of constant text to your
layout but do not need or wish to build a whole new overlay. One example of this
is to add the project name in small print somewhere on the page. This is also a
very good practice to adopt, similar to the reference number or code that external
printing companies often print on pre-printed stationery.

Constant text is defined as a field on a given printline, and consequently will be
specific to the page format that the printline occurs in. If your project includes
multiple page formats you will have to add the constant text to all formats to which
it applies.

1.13.1 Adding constant text in the View/Edit window

1. Activate the View/Edit window, and using the left mouse button, select an
existing field that is going to print on the page. Click on Tool - Append field
from the main menu.

2. You will be presented with the Field Properties dialog. Click on the Fixed text
tab. Click on the Fixed text box and enter the text string for the field.

3. Click on the Font 1 tab and make the desired selections. Select OK.

4. This will take you back to the View/Edit window with the positioning cross hairs
displayed. Use your left mouse button to place the constant text where you
wish. It will now print any time the page format is activated.

1.14 Creating a landscape project

In the previous examples, data was presented in what is commonly known as
portrait orientation (where the narrow edge of the paper is at the top). Infoprint
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Designer may also be used to create projects that are rotated to a landscape
orientation, namely the data is oriented so that the long edge of the paper
appears to be at the top.

There are some unique parameters that must be set correctly for the output to be
generated with the correct orientation. This is true for any landscape project.

This section describes how to generate an Infoprint Designer project to simulate a
function that is widely used on the iSeries for printing, namely Computer Output
Reduction (COR). COR is normally implemented without Infoprint Designer by
setting the printer file parameter for Page Rotation (PAGRTT) to *COR or *AUTO.

This is the default used in iSeries printer files, such as QSYSPRT, QPJOBLOG,
or QPSUPRTF. With PAGRTT(*COR) or PAGRTT(*AUTO), output that is normally
destined for impact printers with forms that are 14 inches wide and 11 inches long
is automatically reduced to print on cut sheet printers on 8.5 by 11 inch paper. For
a complete description of the rules of COR, see iSeries Printer Device
Programming, SC41-5713.

The advantage of using COR is that a programmer does not need to make any
changes to print simple reports that were 132 or 198 characters wide by 66 lines
long (based on 10 or 15 characters per inch and 6 lines per inch).

The disadvantage is that there is no flexibility. The font is predetermined and may
even be different on different types of devices. Customers who previously
changed their printer files to fit on legal (8.5 by 14 inch paper) cannot take
advantage of COR if they must further reduce the output to 8.5 by 11.

With that said, it is possible to simulate the function of COR using Infoprint
Designer while at the same time add other enhancements that are otherwise not
available, such as:

« Adding an overlay
» Changing fonts for different parts of the report
< Adding conditional processing to format different pages differently

Note:

This project is not included in the initial shipment of Infoprint Designer. It can
be obtained by ordering the most current PTF for the product.

1.14.1 Understanding page origin

When designing a landscape application, the layout of the output is a function of
how it relates to the logical page origin. In most cases, the origin of the paper is

the top left corner when viewing the sheet in a portrait orientation. When you print
a landscape job, the origin remains at the same spot on the page. However, from
the data point of view, it becomes the bottom left corner.

There are additional considerations when printing to continuous form printers or
when using the n-up function available on some IPDS printer models. For more
information on this topic, see IBM Page Printer Formatting Aid: User’s Guide,
S544-5284.
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1.14.2 Creating a landscape overlay

The page size and orientation for an overlay are controlled by the overlay
settings. While you are using the Overlay editor, select File->Overlay Setup.
Then, select the Size tab. The panel shows the defaults, such as Horizontal (8.5
inches) and Vertical (11 inches) for Letter paper, with a O degree rotation. Do not
change the Horizontal and Vertical values. Change the Orientation radio button to
90. This causes the Horizontal and Vertical values to switch automatically.
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Figure 30. Overlay settings for landscape

Figure 30 shows the panel that appears after selecting the desired rotation. When
you close this dialog and return to the View/Edit window, the overlay frame (thin
red line) reflects the new paper dimensions.

1.14.2.1 Using images on a landscape overlay

When you place a page segment on an overlay, its relative orientation, with
respect to the origin of the page, remains constant (even if you define the overlay
as being at 90 degrees). If you have a page segment that is normally used for
portrait projects, you must make a new, rotated version of it for a landscape
project. You can do this without leaving your Infoprint Designer project by
following these steps:

1. While using the overlay editor, select File->Get image. Select the original
(portrait) image and click Open.

2. The image may be placed off the top of the page boundary, but you should be
able to see the blue outline box in the top left corner of the View/Edit window.
Use the mouse to drag the blue box to an area where it is more visible. The
image appears to be rotated. Figure 31 shows an example of a portrait image
when it is initially placed on an overlay that is set up with Orientation 90.
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Figure 31. Portrait image on a landscape overlay

3. To rotate the image to 90 degrees to match the overlay, right-click on the blue
box surrounding the image. The Page segment properties panel appears.
Select the Rotate tab and click the radio button for Rotate: 90.

4. You are prompted to save the new page segment in your library path. A useful
convention is to add “90” to the original name (in this case SS2TOP90).
Figure 32 contains an example of the panel.
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Figure 32. Saving the rotated page segment

Note:

If you are using Infoprint Image Editor to create your images, you have the
opportunity to create the rotated versions by selecting Image->Rotate from the
menus list or by selecting the Rotate the image icon.

1.14.2.2 Overlay specifics for COR project
When COR is used, the interline spacing is reduced to 70 percent of the original
specification. Output that normally prints at 6 lines per inch (or .1667 inches per
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line) is reduced to 8.571 lines per inch (or .1167 inches per line). Each of the bars
on this overlay accommodates three lines of print (or .35 inches). The outside box
should be at least 10 inches wide and 7.7 inches high to accommodate output
that has 132 characters by 66 lines. Add some extra white space to improve
readability.

When dealing with an application like this that requires very precise
measurement, it is a good idea to use the positioning section of the tool bar to
accurately place each element on the page. Figure 33 shows an example of the
toolbar for the first box on the overlay.
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Figure 33. Positioning section of the toolbar

Figure 34 shows an example of a completed overlay that is used in the COR
simulation project.
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Figure 34. Sample overlay for COR simulation

1.14.3 Creating a layout for landscape printing

As with the overlay, the data that you map on the page using the layout editor is
positioned and oriented based on the origin of the page. If you start your project
by creating the landscape overlay, and then switch to Layout, the overlay appears
sideways. This will be rectified by rotating the layout. Figure 35 on page 40
illustrates the relationship between the origin of the page and the placement of
data for portrait and landscape orientation.
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Figure 35. Portrait and landscape presentation

To set up your layout for landscape printing, select Edit->Page properties .... In
the case of a letter size application, you see an X value of 8.5 inches and a'Y
value of 11.0 inches. Do not change these. Select the radio button for Direction
Down. The X and Y values switch for you. Figure 36 shows the panel you see
when you do this.
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Figure 36. Page properties for landscape layout

You do not have to select the Orientation tab from this window unless you are
printing on a continuous forms printer. IBM Page Printer Formatting Aid: User’s
Guide, S544-5284, describes the relationship between the values for Direction
and Orientation.

When you close the Page properties dialog, the page size in the View/Edit
window should reflect these changes, and the overlay should be presented in the
correct orientation.

1.14.4 Layout specifics for COR project
There are a number of things you must be aware of when creating a layout for a
landscape project (in particular, one that simulates the COR function):

1. If the original application is set to print at 10 characters per inch (cpi), COR
converts that to a font that prints at 13.3 cpi. When selecting a font in Infoprint
Designer, use a fixed pitch font (such as Courier or Gothic Text) and select a
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Size of 9 points. Use the information in Table 3 to determine the correct point
size depending on the original spooled file cpi setting.

Table 3. Font size selection for COR

Original cpi COR cpi point size
10 13.3 9
12 15 8
15 20 6

2. The interline spacing used by COR is 70% of the standard spacing. This works

out to 0.1167... inches (or 8.5714... lines per inch). To avoid any chance of
rounding errors, you may choose to use the pels units of measure. Infoprint
Designer uses 240 pels per inch. This number is not affected by the selection
of Host Printer Resolution in the General tab in the Preferences dialog. At

6 lines per inch, standard output measures 40 pels. With COR, an interline
spacing of 28 pels is used.

— Note:

It is important to set the Infoprint Designer Preferences for Vertical unit and
Line spacing unit prior bringing in the sample data and working on the
Layout portion of the project. Select Edit -> Preferences and click the Units
and Grids tab. Figure 37 illustrates the dialog box. If you do not do this, you
may find you get “out of page boundary” errors when uploading your project
to the iSeries. See 1.14.7, “Boundary errors” on page 44.
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Figure 37. Setting preferences for units and grids

3. After you have mapped the data to the View/Edit window, click on any line of

data but the first, and verify the value for s: in the positioning section of the
toolbar. An example of this is shown in Figure 40. If the incorrect value is
displayed, it probably means that the Preferences were not set correctly. It is
best to fix the preferences, refresh the sample data, and redo the mapping.

. When mapping the data, ensure that you select all of the records and the
entire length of the records at one time. This ensures that any font changes
you make to the first field affect the entire page and that the selected line
spacing is used throughout.
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If your data does not allow for this, you can fix the layout after performing the
initial mapping. Left-click the first line of data and then right-click to bring up
the Field properties window. Click the Printline properties button. On the
Printline properties window, change the value for Repeat: to reflect the
number of lines you want to map (for example, 66).

For example, the sample COR project was created using an iSeries JOBLOG
that had 60 lines of data per page. By modifying the project to support up to 66
lines, it will generate resources that can be used by a wider variety of iSeries
reports.

5. If you change the repeat value, you may find that there are extra unused
printlines in the page definition. It is a good idea to look at the page definition
tree. It should be similar to the page definition shown in Figure 38.
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Figure 38. Page definition for sample COR layout

6. Some points to note regarding this page definition:

a. If you mapped all of the records as one repeat group, there should be one
printline on the subpage indicating the desired number of repeats (in this
example, (R1-66)). Any extra printlines must be deleted.

b. The CH1 indicates that this printline is activated any time there is a “1” in
the first position of the data record. This ensures that a new page is started
when required. Make sure you have not modified or deleted this setting in
the course of making other changes.

c. There are two fields mapped in the one printline definition.

d. One field (probably the second) was generated when you dragged and
dropped the map data. It should reflect the correct line length. If it requires
adjusting, right-click on the field entry and change the value in the Length:
box.

e. The other field is generated automatically by Infoprint Designer and
references the DFLT suppression. See 1.8.3, “Infoprint Designer and
suppression” on page 23 for more information on the DFLT suppression. To
determine which field is which, right-click on one of the fields to bring up
the Field Properties window. Then, left-click the Suppress button. The
Name: field contains the value DFLT for the ‘Suppressed” fields, and is
blank for the fields you map intentionally. If, and only if, all lines of your
original spooled file are to be mapped, you may delete the “Suppressed”
fields.
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Figure 39. Completed COR project

Figure 39 shows an example of the completed COR project using sample data
from a job log. In this view, the third record was selected to show the s: value of
28 pels for interline spacing in the toolbar. The entry in the toolbar confirms that
Records 1 through 66 are mapped together, are triggered by a Channel 1, and
that a field from 1 to 132 bytes is mapped.

We recommend that the user create a similar landscape project before attempting
one that is more complex.

1.14.5 Using the COR project on your iSeries

You can use this project with many iSeries system printer files that default to 132
columns by 66 lines. This example illustrates using using it to format a job log
listing.

1. Determine the printer file name for your listing. In the case of a job log, the
printer file used is QPJOBLOG.

2. Enter to command to override the printer file with the parameters for using the
COR project:

OVRPRTF QPJCBLOG DEVTYPE(*LI NE) FCRVDF(GOR) PAGDFN( OCR)  DUPLEX( * FGRMVDF)

If you choose to use this permanently, make a copy of the QPJOBLOG printer
file in a user library and use the CHGPRTF command to make the changes.

3. Enter the command to create a printout of your current job’s joblog:
DSPIABLGG * *PRINT

The joblog generated should print using the new form definition, page
definition and overlay.
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1.14.6 Variation of a theme

In the previous example, not much was done beyond simulating a function that
the iSeries already performs quite easily. This apparently redundant exercise was
performed because, once you understand how to create a relatively simple
landscape project, you can use the features of Infoprint Designer to take it to the
next level.

1.14.6.1 Using multiple fonts

As you may have discovered while working on this or other projects, records that
are handled in exactly the same manner are grouped as repeats within one
printline. If you want to use a different font for the heading section of a report
(compared to the body), you must define two separate printlines. Perform this as
two separate mapping operations.

If you make a mistake, you can often fix it from the page definition tree by
adjusting the repeat values or erasing extra printlines.

Use a high zoom value to align the different sets of data correctly. An alternate
approach is to perform some calculations first so you can precisely position the
elements.

1.14.6.2 Conditional processing

Some reports may have different formatting requirements for a heading page at
the beginning or a summary page at the end. You may use Infoprint Designer’s
conditional processing feature to identify those pages and handle them
accordingly.

A large report may have logical sections within it for different regional or
departmental information. Select the When Change radio button in the condition
definition to trigger the selection of a different copy group that uses a colored
paper from a different drawer.

1.14.7 Boundary errors

One common problem encountered during testing was the occurrence of a
message, such as :

(RL-66) OHL position exceeds the |ogical (PAGEL) boundary

This message is generated at the time the project is uploaded to the iSeries
server. The cause of this is likely incorrect settings for line spacing on the
Printline or individual field properties. This is often a result of not setting the Units
and Grids tab under Edit -> Preferences correctly, before beginning the layout.
However, it is possible to rectify the situation after the fact.

To bypass this error, check the Line Spacing settings in the Printline properties
and in the Field properties. In all cases, they should be set at the correct value for
your application (for example, 28 pels). To do this, right-click on the Printline and
select the Orientation tab. The Line Spacing setting appears on that window as
shown in Figure 40. Change the value if necessary. Repeat these steps to check
the Line Spacing value for the two fields.
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Figure 40. Changing line spacing for a Printline

After making these changes to the line spacing, minor adjustments may be
required to the position of the first line of print.

1.15 Multi-up bar code labels

The example in this section shows how Infoprint Designer may be used for a
Multi-up application, which means that many logical pages from the original
application are placed on one physical page.

This example also demonstrates the use of bar codes.

Note:

This project is not included in the initial shipment of Infoprint Designer. It can
be obtained by ordering the most current PTF for the product.

1.15.1 Project description

Super Sun Seeds prints bar code labels to place on seed packets. These labels
are printed four to a page in a landscape orientation. Each label has a product
number printed as a bar code, the product name, quantity, and a short description
of one to three lines. The spooled file is generated with the information for each
label as if it were to be printed on a separate page. This is referred to as the
logical page.

1.15.2 Overlay creations for SEEDS project

Begin a new project, SEEDS, starting with the Overlay definition. Select
File->Overlay setup->Size to change the overlay Orientation to 90.

Start the overlay by drawing lines to separate the quadrants of the page. These
help you position the other elements as the project is developed. If you want, you
may delete them when you are done. Draw other lines and boxes as needed.
Design all the elements for one of the labels and then use the group function to
copy the complete label to make the other three labels. If you are using any page
segments, ensure you use the rotated versions.
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1.15.3 Mapping data for the first label

When the overlay is complete, save your overlay and then click the Layout
button. Select the source for your sample data. In this project we have used the
PC file seeds. dat . When you are presented with the Line data options window,
notice that the page length defaults to 66. Change this to “4”. This corresponds to
the maximum number of data records that appears on each logical page. Doing
this prevents unnecessary printline generation.

Figure 41 shows the sample data as it appears when it is first brought into the
project. For the benefit of those reading hardcopy from a monochrome printer,
note that only the data for the first label (HIGH ALTITUDE WATERMELON) is in
blue. Subsequent labels, or logical pages, are in displayed in red.
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Figure 41. Sample data for label project

Before you map any data onto the page, you must set it up for landscape oriented
printing. Select Edit->Page properties and click the Direction: Down radio
button.

You are now ready to start mapping the fields. The first page of this file only
contains two lines of description. It is better to use the second page (KENTUCKY
BLUE GRASS SEEDS), which has the maximum number of description lines on
it. Click the Next button on the toolbar to activate this page.

Drag the quantity and product description fields onto the first label and set the
fonts for each of these fields.

Drag the item number onto the first label and right-click to bring up the Field
Properties window. Click the Bar code button. The following list describes the
settings used in this example:

« On the General tab of the Bar code options window, you must enter a
reference name for your bar code. This allows you to reuse these same
settings for other fields without redefining each option.

» Select a Bar Code type. In this example, CODE128 is used.

« HRI stands for Human Readable Interpretation. Select this tab to control
whether the data is to be printed above or below the bar code lines (this also
specifies which font is to be used).
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« On the size tab, a height of .5 inches is selected. The element width is set to
20/ 1000 of an inch.

When you press OK on the barcode dialog, the item number is shown in the bar
code on the overlay.

Highlight the three lines of the description and drag them over to the label in one
operation. Change the font and set the interline spacing so that it fits nicely in the
box.

At this point, the first label is complete and it looks something like the example
shown in Figure 42. Use the Top and Next buttons to page through the data to
verify that all of the pages fit nicely.
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Figure 42. Completed first label

1.15.4 Mapping the remaining labels

The next step is to duplicate this mapping for the other three labels. One way to
do this is by brute force. Namely, repeat all the dragging, mapping, and setting of
fonts and other properties. However, it is easier to make copies of the work
performed by working on the Page Definition tree.

Open the Page Definitions window. The page definition for the first label should
look something like the example shown in Figure 43.
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Figure 43. Page definition for first label

There should be two printline definitions. Both have a field of 1-80 for the
suppressed fields. The first printline references record one and have a Channel
code defined. Three data fields are mapped in it. The second print line repeats
from record two through four and maps the description fields.

If extra printlines appear, you must delete them. Left-click them and then press
Delete.

Before you begin duplicating the printlines, you may find it easier to work if you
collapse the fields within the printlines. Double-click the icon for each printline.
The Field definitions disappear and a plus sign appears beside the printline icon.

To copy a given printline, hold down the Ctrl button on the keyboard. Left-click
and drag the icon of the printline you want to copy to the bottom of the tree. When
you do this, the fields are expanded. It is a good idea to collapse each printline as
you go along.

Copy the printline for (R1)CH1 and place it at the bottom of the tree. The new
printline is labeled (R5)CHL1. Next, copy the printline (R2-4) to create (R6-8).
Repeat until you have four pairs of printlines (representing a total of 16 records).
The resulting page definition tree should look like Figure 44.
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Figure 44. Page definition after copying printlines
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While you are making copies of the records in the page definition tree, you may
have noticed two things. In the Data window, the records for the first four labels
are now blue. The layout in the View/Edit window has become quite congested.
Do not be alarmed if it looks something like Figure 45.
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Figure 45. View/Edit window after copying printlines

There are two methods of moving the label data onto the corresponding
guadrants on the page. One is to use drag and drop, and the other is to enter the
locations in the position fields on the toolbar.

Drag and drop method

Left-click on one of the data fields from the first record of the second label. In the
example in Figure 45, the bar code for the Kentucky Blue Grass record is
selected. Notice a small blue anchor displayed near the left margin of the page.
This is the reference point for that printline. Holding the left mouse button, drag
the anchor so that the data for the second label fits in the top right quadrant of the
page. Notice that the data for the third and fourth labels is dragged along as well.

Repeat this process for the other two sets of records.

Numerical method

This method involves a little more arithmetic than the drag and drop method, but
is more accurate. It involves direct manipulation of the x and y coordinate values
for the printlines in the position section of the toolbar. These are the upper pair of
numbers that you see when you click on an element.

By default, each printline prints at the same x value as the previous printline, and
the y value increases based on the line spacing settings in the Printline
properties. The x and y values appear as same and next respectively. What you
must do is determine where the first printline is anchored and then add 5.5 and
4.25 inches (half of 11 by 8.5, for Letter size paper) to the x and y coordinates of
the other three printlines.

Chapter 1. Advanced use of IBM Infoprint Designer for iSeries 49



6250ch07.fm

Draft Document for Review December 9, 2001 1:52 pm

Select one element from the first record of the first label. To view the absolute
position of that record’s anchor change, the units in the printline coordinates on
the tool bar from same and next to inches. The values for x and y should now
appear as 0.00 and 0.17 inches respectively. You can now click on elements of
the other records and change their anchor position accordingly. Make sure you
click on elements from the first record of each of the labels, not the description
records. You can use the information provided in Table 4.

Table 4. X and Y coordinates for each label

Label X coordinate Y coordinate
1 0 0.17
2 5.5 0.17
3 0 4.42
4 5.5 4.42

Using either method, or a combination of the two, the final outcome should look
something like Figure 46. Note the new positions of the anchor for the Kentucky
Blue Grass Seeds label.
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Figure 46. Completed label project

1.15.5 Using the SEEDS project on your iSeries

To print the seeds project on the iSeries, follow these steps:
1. Create a physical file on the iSeries for the data.
ORTPF nyl i b/ SEEDS RCDLEN 81)

2. Use FTP or Client Access to copy the data from the PC file that is used for this
project into the physical file. The file must be translated from ASCII to EBCDIC
during the transfer process. In this example FTP is used.

a. Open a DOS window. Select the directory that contains the sample seeds
data file:

cd Desi gner\ DATA
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. Begin the ftp session with your iSeries:

C \ Desi gner\ DATA>ft p BLDASL1

. Enter your userid and password when prompted.

. Check to see if the destination iSeries library is correct:

ft p>pwd

. If you want to use a different target library, you can change it:

ftp>cd nylib

Copy the Seeds.dat file into the iSeries physical file SEEDS, member
SEEDS:

ftp>put seeds.dat seeds.seeds

. End the ftp session:

ft p>qui t

Create a printer file that uses the project:

ORTPRTF SEEDSPRTF DEVTYPE(*LI NE) FCRVDF( SEEDS) PAGDFN( SEEDS) CTLOHAR( * FOFQ)
Copy the data from the physical file to the printer file:

CPYF SEEDS SEEDSPRTF

This generates samples of the Super Sun Seeds labels.

1.16 Putting the application into production

To utilize the AFP resources you have created and transform the original
application, you must override or change the printer file to:

e generate line data

refer to the page definition AFP resource name
refer to the form definition AFP resource name
use the Drawer selection from the form definition
use the Duplex selection from the form definition

You must also ensure that the AFP resources can be located by the print writer
(i.e. PSF/400)

1.16.1 Change printer file to *LINE data

The printer file DEVTYPE parameter dictates the format of the data stream the
iSeries will produce. The default is *SCS. For printing using an Infoprint
Designer-enhanced application this must be changed (or overridden) to *LINE.
You can identify the printer file from the spooled file attributes. Use option
8-Attributes against a list of spooled files on your system. You would then use the
following command to invoke this change:

CHERTF printer_fil e _name DEVTYPE(*LI NE)
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Press Enter to continue.

Figure 47. Identifying the printer file that created the sample spooled file

1.16.2 Override printer file to use *LINE data

In Figure 47, the printer file is QSYSPRT in library QSYS. This is an example of
where an application-specific printer file has not been used. The “Q” prefix tells
us this is an IBM-supplied printer file and we do not recommend changing this
printer file (else screen prints and much other output will be affected). Instead you
must track down the programmer and the step in his or her code that overrides
the QSYSPRT printer file. You can then arrange for the device type parameter
(and the page and form definition parameters) to be altered.

1.16.3 Add page and form definitions to the printer file

Use either the CHGPRTF or OVRPRTF command as described above to add the
page and form definition names, and their library, to the application printer file.

1.16.4 Duplex and drawer selection

PSF/400 will use the value specified in the printer file for Duplex and Drawer
selection over any such specifications in the form definition. Change or override
the printer file to select DRAWER(*FORMDF) and DUPLEX(*FORMDF) to make
sure the design you created in Infoprint Designer is activated correctly.

1.16.5 Library lists
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As with all AFP resources the iSeries must be able to find the resources, i.e. in an
accessible library list. If you get missing overlays, logos, etc. from your output, the
most likely cause is that the library to which you uploaded the resources is not in
your library list.

For interactive work (probably testing) you can add any resource libraries to your
own library list (EDTLIBL). For batch application, add the libraries to the printer
(Device Resource List in the PSF configuration object), or to the job’s library list.
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1.16.6 Create / copy printer file with *LINE data, place higher in library list

If it is not possible to change the printer file and you do not have access to the
system code that runs the application, it may be possible to locate the printer file
as above, then take a copy of this (or create a new one from scratch). It must be
the same name as the original (because the application will refer to it by name)
but if we store it higher up in the library list, with our page and form definitions
and *LINE data parameter added, PSF/400 will then locate and use this printer
file first.

1.17 Problem quick-fixing

This section is a quick-fix guide to problems you may experience.

1.17.1 Library profile must exist

Infoprint Designer stores all the library path names in the Default.lbp (or
Raster.lbp file - see 1.2, “Setting up the PC libraries” on page 3). It expects to find
this text file in C:\DESIGNER\USERISIS. If for some reason this file is moved or
missing, symptoms include:

« no fonts, or other AFP resources, available to work with
* blank name displayed for Library in the Libraries dialog box
* Messages such as the one shown in Figure 48
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Figure 48. Failure to find default library for overlay resource

To correct this problem, use Edit - Change library and select the correct library
profile file.

1.17.2 Missing resources

Figure 49, “Page segment missing from imported overlay” on page 54 shows the
results of opening an overlay referencing a page segment (separate AFP
resource), the location of which is not known to Infoprint Designer. To correct this,
either copy the AFP page segment into the correct Infoprint Designer resource
library, or add its path information to the library profile. We will look at both
examples.
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Figure 49. Page segment missing from imported overlay

1.17.2.1 Copy missing resource to Infoprint Designer library

To place a copy of the missing AFP resource into the Infoprint Designer resource
library, simply use Windows Explorer to copy/paste the AFP resource into the
appropriate PSEG library (PSEG300 in this example). Now right mouse
button-click in the red boxed area representing the missing resource. This brings
up the Page segment parameters dialog, from where you can click Refresh. The
page segment should then be displayed

1.17.2.2 Add path information to Infoprint Designer

This method leaves the AFP resource where it is (perhaps on a network drive)
and tells Infoprint Designer in which library the resource is to be found. To add the
directory where the resource is location to the Infoprint Designer library, you will
presented with a dialog similar to the one shown in Figure 50 on page 55. Enter
the path of the customer library and the file extension in the Path entry field and
click Append. Make sure you have the correct resource tab selected, in this case
Overlay.
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Figure 50. Adding the path and file extension of a resource to the library profile

We recommend you use the latter method, i.e. add the path and file extension of
the resource to the Infoprint Designer resource library. This has the following
advantages:

* resources are kept in the location of your choice

* resources may be backed up more easily

 resources are kept separate from the IBM-supplied programs and code

 extra / alternative resource suffixes may be defined and added (such as those
in Table 2 on page 5).

However you should be aware that there is a 1024-character limit to the list of
path names for any one resource type.

1.17.3 Data shown on constant back overlay

If you are using a Constant Back overlay, as described in 1.11, “Adding a
constant back to a subgroup” on page 29, you may notice the following problem.
As you page through the Data Window, using the Next and Back buttons, you will
see data displayed along with the back overlay. This is because we are in effect
trying to show both the front and reverse sides of the document on the PC screen.
Unfortunately Infoprint Designer only displays pages using the data in the sample
file, so it superimposes the data from the front side on the constant (back)
overlay. Rest assured that the data intended for the front sides of the job will print
correctly and no data will print on the constant back sides, so the pagination of
your job will be correct when you send the job to the printer.

To work around this, you can temporarily prevent Infoprint Designer from
displaying the back overlay once you have verified that they are being included at
the correct points. To do this, deselect Merge windows in the Window menu
option.

1.17.4 License issues and information

Only one copy of Infoprint Designer can be used on an iSeries system at any one
time. However you can install multiple copies of the client on multiple PCs.

Chapter 1. Advanced use of IBM Infoprint Designer for iSeries 55



6250ch07.fm

56

iSeries 400 Printing VI

Draft Document for Review December 9, 2001 1:52 pm

Infoprint Designer can only be used while it has a “live” session with the iSeries
system. If another user starts up an instance of the client, the software runs in
“Demo” mode, where file save and the Upload functions are disabled.

There is a PRPQ offering from IBM to support multiple simultaneous users of
Infoprint Designer, should you feel this is necessary. (PRPQ stands for
Programming Request for Price Quotation i.e. an IBM-modified program product
offering). The program number for this PRPQ is 5799-GPW.



